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Comp 96, Summer Session 2, 2001 Asg-01 
 

Asg-1:  The Web;  and USENET News 
Date assigned: F, 29 June. 
Date due: T, 3 July. (send email no later than 5:00 p.m.) 

Objectives:  To learn better techniques of using the Web for research; to get familiar with USENET.   

Note:  If you are new to computing or to Windows, feel free to see the TA for some help first, to get you 
started.  Remember, if you use a PC at a campus lab, you'll need to know your USER ID and Password 
(refer to Asg-00) to log on to Windows. 
Note:  If you already consider yourself a fairly decent Web surfer, simply peruse over the explanations 
below until you get to Part I−−−−D for TURN IN (just in case there's something you didn't know).  Don't forget 
to complete the Usenet News portion, however. 

About the assignment 
1. For this assignment, you will find a number of Web pages (Part I), and then a few Usenet newsgroups 

(Part II), and send your reaction to what you read in an email message to me.  All details are provided 
below.  You can treat this assignment as two separate parts if that's easier, and email your assignment 
as two separate messages; or keep your email window open and add Part II to Part I before you send it.  
Just be sure you remember to send both.  If you run into difficulty, see me or a lab assistant. 

2. WARNING!  The Web and USENET Newsgroups will present you with opinions, words, images, and 
sounds from all over the world.  Topics range from information about the National Park Service to the 
charters of hate groups.  Some of what you find may offend you.  One objective of this course is to 
explore what is "out there" and then to discuss possible implications.  For example, we'll soon explore 
topics related to "indecency" on the net, censorship, freedom of speech, etc.—so try to keep an open 
mind.  However, if you've gone somewhere and would prefer not to continue there, then please turn 
back.  If you are uncomfortable with something you run across, ignore it and find something else. 

PART I.  WORLD WIDE WEB 
1. For those of you who may not have been on the Web before, here's a very brief primer:  When you see a Web 

page, you will see words and blocks of text that are displayed in a different color than the rest of the document 
and/or underlined.   These are the hypertext links (hyperlinks) that you will click on once to produce that 
corresponding Web page.  Many icons or parts of images can also be links—if you pass the cursor over text or a 
picture and the cursor turns into a hand with pointing finger, then that spot is a link. 

 First you'll explore, and then you'll do the assignment portion that you will email to us. 

A. Launching Netscape or Internet Explorer (IE) 
1. The steps provided here relate to using Netscape from a PC at a campus lab (such as Venable or the 

Undergrad Library).  If you prefer, you may use a Macintosh, and/or you may use another Web browser 
(such as Internet Explorer).  If you have a problem with getting started with this assignment, try asking 
an ATN assistant for some guidance (show him/her this paragraph); if you have major troubles, see the 
instructor or a lab assistant before you continue.   

2. Double-click on the Netscape Communicator shortcut on the desktop (or launch it from the Start 
button).  Notice the status messages at the bottom of the screen as it contacts the host computer and 
retrieves the Web pages.  You should see a slick Web page for the ATN help desk, along with their 
hyperlinks.  If it seems to take too long to load, click on the Home icon button in the top bar and wait.  
Now, move the cursor around the page—notice how it becomes a pointing hand when you move it over 
the hyperlinks.  You will follow each link by single clicking on it, which you’ll do shortly. 

B. Opening a Web Document via its URL 
1. If you want to view something that you don't have a direct link to, one way is to enter its URL (Universal 

Resource Locator—a Web page address).  First let’s look at the home page for this class: 
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2. Under the File menu, select the Open page option.  

 Type the following URL in the box exactly as it is written here (no spaces), making sure you use a 
lower case ‘C’ for comp96:   

www.cs.unc.edu/~awilson/comp96      then press the Enter key (or click the Open button). 
2. Follow some of the links from this page.  Then follow some of the links from those pages.  Use the 

Back and Forward buttons to move back and forth to pages you've visited.  Remember the Comp 96 
home page for future reference—a list of handouts, assignments, readings, due dates, etc. will be 
posted here every two days. 

3. Visit JMW's Computers and Society Topics Page (currently being updated!) and follow some of its 
links.  It should come in very handy for your papers.  

Shortcuts…to cut down on typing long URLs.  From any Web page, click inside the "Location" box at the top of 
the Netscape window—where the current URL is listed—and either replace or edit that entry, then press 
Enter to engage the link.  Notice if you click once in the box, it highlights the entire entry—whatever you 
type will replace the entire entry; if you click a second time while the pointer is somewhere in the entry, 
you'll be able to edit only the parts you want.  Also, with today's browsers, you can omit typing the http://  
part. 

TO SAVE TIME:  If a Web page seems to be taking too long to download (seems stuck), click on the 
Stop button, then click on the Reload (or Refresh) button. 

4. More links to try:   

 Explore some of the links from the pages listed below and the links from those pages, and so on.  
Practice using the Back and Forward buttons.  If you get too lost, just click once on the Home button, 
which should bring you back to ATN's help page.   

 Also try out some of the handy links that have been Bookmarked by ATN (click on the Bookmarks 
button, and select).        

www.unc.edu/ (UNC's home page; follow some of its links—lots of campus info)  
www.nandonet.com/ (The NandoTimes—current national and world news) 
www.webweather.com (International Web Weather center – may load slowly)
www.ubl.com (Ultimate Band List—music resources all over the Web, music review, 

band's Web pages, etc.)
 Attached is a sample of other interesting, helpful, and fun URLs that you can try.  Have at 'em.  

C. Subject Indexes and search engines (understand the difference) 
1. If you don't know the URL for certain pages or those that deal with specific topics, Netscape has a 

number of features to help.  Notice the button at the top of the window labeled Search.  Click once on 
the Search button now.  (In IE 5, you use the left-hand frame to type in your search words.) This brings 
you a page with links to pages that use search engines and Web indexes.  Those are the two main 
avenues for searching the Web. 

Subject index or directory 

a) A collection of links created and submitted by PEOPLEsite creators or evaluatorsand 
organized into subject categories.   

b) The best are directories created by academic institutions such as universities, institutions, 
professional librarians, etc. (visit our Useful Links to Explore page, and click on Libraries and 
Subject Directories). 

c) Some commercial directories are useful (such as yahoo.com), but don’t over-rely on them: they 
generally provide links sent in by content providers, or by other users.  There isn’t much quality 
control. 

Search engine 

a) A searchable database of Internet files collected by a COMPUTER PROGRAMsometimes 
called a web crawler, or spider, or robot, or worm.  An index is automatically created from the 
files it collects. 
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b) Newer engines use some artificial intelligence and some selection criteria; for example, 
askjeeves.com and looksmart.com  can lead you to popular sites chosen by other users, or that 
are linked to by what they consider to be high quality sites.  Give those a try! 

 Generally what you'll see on the search page is a small box in which to type your keyword phrase, and a 
Search, or Find, or Go Get It button to click on afterwards.  The search tool will return all of the pages 
that seem to match your request.  The Netscape Search page also provides links to white and yellow 
pages, and other topic-specific links.   

Myth:  Search engines and indexes provide access to EVERYTHING on the Web. 
Yahoo, a very popular index, links to less than two million sites that vary widely in quality.  (Nov 1999, 
The Teaching Professor).   Even the largest search engine covers only 16 percent of total Web content 
(www.wwwmetrics.com). 

So which should I use for my research? 
Generally speaking, subject indexes are useful for broad topics, and to gain access to sites selected 
and annotated by human experts. 

Search engines are good at narrow/more obscure topics, or to find a specific site. 

 Below are a few excerpts, with some editorial license taken, to peruse before you try these out: 

 ComputerLife, August 1997 
Search engines work best when you have a particular topic in mind, such as fantasy baseball leagues or 
Quentin Tarantino movies, that can be expressed in specific terms.  Most engines use a complex algorithm or 
calculations to analyze your keywords and deliver results based on what the engine "believes" is most 
relevant.  Even with a tightly focused search statement, you'll sometimes be faced with hundreds or 
thousands of documents.  You can usually ignore 90% of them; the items that contain all your keywords are 
likely to be clustered toward the top, and chances are you'll find what you want among the first 25 to 40 links.  

 Raleigh News and Observer (date unavailable) 
Make your life easier:  narrow your search.  If you're looking for the proper way to plant tulip bulbs, don't just 
type tulips.  Try:  tulips bulbs planting season depth.  The documents matching all words will be returned, 
and your chances of learning how deep to plant tulip bulbs and when to plan them are much better.  Take a 
minute to read the searching tips that almost all searching sites offer.  May take you an extra five minutes 
on your first search.  But learning that the "+" sign returns only the Web documents containing both words, 
or that words like "not" can be used to screen out documents, can save lots of hassle over time. 

2. Try out some of the search tools now:  Just click on the tool button you want.  For example, to use 
Excite, click on its button (if it's not already the pre-selected one—different search tools come up each 
time).  To get directly to Excite, type its URL:  www.excite.com .  Notice the blank white box to the left of 
the Search button.  Click on it and type in a few key words (for example, French Merlot wines), then 
click on the Search button.  OK, now check out the links it returns to you (you may need to scroll down 
the page).  Click on some of the first few links that look appropriate to your search.  How did it do? 

Hint:  If you do not find what you're searching for with one tool, try changing your keywords, or try a 
different tool altogether.   

 Also, you can use the subject links that Excite provides.  Just keep following links down from subject to 
topic, etc., until you find something of interest. 

Note:  Tired of getting a hundred+ hits for every search you try?  Learn simple and immensely useful hints at 
the Search Engine Page:   http://www.searchenginewatch.com/facts/math.html. 

3. Try the following Web indexes, then follow some of the subject links, and their links, until you find 
something of interest.  Go down as deeply as you please. 

www.snap.com and www.yahoo.com

4. Try the following subject indexes with some artificial intelligence built incan lead you to popular sites 
chosen by other users, or that are linked to by what they consider to be high quality sites.  You type in a 
question in natural English. 

www.aj.com www.looksmart.com www.google.com (my favorite)
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One directory definitely worth checking out is the Electronic Library at  
www.elibrary.com

The information here comes from commercial sources, and can be trusted more than other things 
you may find on the Web, which may or may not be factual.  [This is a great site, and continues to be 
free.  Consider using it again for your papers!] 

Another is a site maintained by a reference librarian at U of TN–Knoxville:  
www.lib.utk.edu/refs/search.html

 This directory site provides descriptions and SEARCH TIPS for the best search engines, leads 
to subject guides to the Web, and it offers links to several sites for more information.   

D. Your Web assignment—to TURN IN via email 
1. First you will find three (3) different Web pages, using at least two different techniques described above.  

(Read #2 below as you find each page.)  In other words, find at least one Web page from each of the 
following three categories: 

a. A page relating to one of your favorite hobbies. 
b. A page relating to a topic that you have always wanted to know more about, but know little or 

nothing about now.  Anything will do—growing tomatoes successfully, how a tornado forms, the 
Great Wall of China—whatever you are interested in.  (But different from a or c). 

c. Something you care deeply about—an issue of personal importance or significance (world 
peace; equality of sexes; environment; cancer—think about this one a bit, but be sure it's 
different from a. or b.).  

2. Tell us about each of the three pages you find.  Write a short paragraph and your reaction to each one.  
Send your three blurbs to us via email, as follows: 

 Keep Netscape running (minimize its window if that helps).  Open up an email session (log on) and 
get into your favorite IMAP mail client (refer to Asg-00). 

 Send an email message to 
 awilson@cs.unc.edu 
 Subject line:   Asg-01, COMP 96              
 Include your real name as the first line of your message.    

 type:  PART I:  WEB 

 And, for each of the three Web pages, you must include: 
a. The complete URL,  and title of the page.  Make sure the URL is accurate so we can find 

it!  (Please COPY and paste it….ask if you need help.) 
b. A brief description of the page. 
c. The category from #1 above (a, b, or c); why you think it fits into that category; and your 

reaction to what you found there (just a paragraph or two for each web page).  Include 
other related comments that you think we may find of interest.  Don't be afraid to be candid.  
(Yes, there's plenty of sand in with the pearls.)  

Type the word "Pledge" followed by your initials at the bottom of message. 

NOTE:  You can send this Part I email message now if you'd like, or else wait until you've 
finished Part II.  Either way is fine. 

 

PART II.  USENET NEWS 
Note:  you will likely need to complete this portion of the assignment at a campus 

laboratory. 
A. Reading USENET News 
1. A few words about USENET news 
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 USENET news—which you'll learn a bit more about later—is a huge conglomerate of public electronic 
bulletin boards.  Bulletin boards are created for different interests:  topics cover everything from Rush 
Limbaugh, to skydiving, to Celtic culture.  Newsgroup names generally consist of three or more 
words, separated by periods, and provide somewhat of a description of the kind of messages (called 
"articles" or "posts") that are sent (or "posted") to that group.  The first part identifies the type of group, 
while successive parts identify the subject and a particular topic within that subject.  For example, 
sci.bio.ecology is a science group, focusing on biology, with an emphasis on ecology.  The group 
rec.music.beatles is a recreation group that focuses on—what else?—music by the Beatles.  You will 
subscribe to various newsgroups (which you must do before you can do anything else), and read 
some of its messages, called articles. You can also respond to an article, or send (called "posting") 
your own if you'd like (not required).  News is an easy way to get into discussions with others with 
similar interests.  Some newsgroups are local, some are national, and some worldwide. 

 USENET includes the so-called "Big 7" topic groups, called hierarchies:  they begin with comp, misc, 
news, rec, sci, soc, and talk (computer-related; miscellaneous; new administration related; 
recreational, scientific; social, talk)   Most sports are in rec.sport,  movies and music are found under 
rec.arts.movies and rec.music.  If you don't find anything you like, you might want to look at the alt 
groups (alternatively administrated), which are a part of the larger Netnews.. Again remember that 
many of the groups are intended to be jokes (many are completely tasteless) or simply bizarre, so you 
probably won't find anything you like in alt.sport.dwarf-tossing. 

 First, peruse Part B below, so that you'll know what you will have to turn in (by email) for this part of 
the assignment.  You'll practice just a little first. 

2. Reading USENET News With Netscape Communicator   

 First, you must download the entire list of Newsgroups, then subscribe to some of them; next, you 
view them with the “Message Center,” a window that incorporates email and news-oriented mail in one 
interface.  Ready? 

a. With Netscape Communicator running, select “Preferences” from the Edit menu.  Wait a few 
seconds.  See the frame on the left side?  Click on the + next to Mail&Newsgroups to display 
a list of categories (i.e.. Identity, Mail Server, etc.).  Click on “Mail Server” and then type in the 
Outgoing mail server user name box your ATN UserID—the one you use for email—without the 
trailer “@email.unc.edu”.   Click OK button. 

b. Go to the Communicator menu, and select Newsgroups.  A News window should appear. 

c. From the File menu, select Subscribe: a subscription window appears.  STOP AND WAIT!!!  You 
must wait until the entire newsgroup listing has been downloaded BEFORE you can go on (see 
the "Read" status message at the bottom of the window?  This could take about 1 to 2 minutes, 
so relax). 

d. Once the list has been downloaded, you will see a list in the middle box.  Here comes the trial 
and error part.  First, you will provide different keywords in order to find newsgroups that deal 
with topics of interest (refer to Part B again if you want to start getting things ready for the turn-in 
part of the assignment): 

 Click on the Search tab at the top of the subscription window.  Type in a single keyword (for 
example, cooking, or video games) and click on “Search Now.”  (But try your own words!)  If your 
keyword search was successful, it will show you a list of groups related to that key word.  IF NOT, 
don't panic.  Try a different keyword until you get a list of groups.  Don't get discouraged; there 
are thousands of topics.  (Think about your favorite pet, sport, hobby, author, food, academic 
subject, whatever.) 

 To select particular newsgroups that look interesting, just double-click on the ones to which 
you would like to subscribe.  After you do, a check mark will appear in the column under 
“Subscribe.”  (You must subscribe to a newsgroup before you can read the messages posted 
there.)  Note in the message column that many newsgroups do not have any messages in them 
—be sure to select newsgroups that have messages in them.  To see more newsgroups, open 
the folders in the list by clicking on the + signs next to them. 

e. Continue to find other newsgroups that deal with different topics by entering other keywords (one 
at a time) into the search box and clicking the Search Now button.  Again, subscribe to more 
newsgroups by double-clicking on them. 
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f. When you think you’ve searched and subscribed to enough newsgroups, click on OK.  That will 
take you back to the “Message Center” window.  From here, just click on the + next to 
“news.unc.edu” (if necessary) to list all the groups to which you subscribed.  You can read the 
messages (also called "articles") in any of these newsgroups by clicking once on the name of a 
group.  A discussion group window will appear with all the messages posted in the group you just 
selected.  To read a message, double-click on it.  (Note:  after you read a message, you can 
close its window and keep going.)  Read away!!!  

g. When you finish reading messages from that newsgroup, close its window and then read 
messages from another newsgroup.  And so on. 

 Remember the warnings; go elsewhere if you're uncomfortable with a particular newsgroup 
or article. 

 You will not have to send (also called "post") articles to newsgroups for this assignment.  
However, if you want to, I encourage you to be a lurker (one who only reads articles) for a while 
first, so you learn the group's culture.   

B. Your News assignment—to TURN IN by email 
1. You will choose two different newsgroups and read at least three articles from each.  The 

categories are: 
a. Entertainment (movies, music, performing arts, etc.).  Most of these will also be under rec 

or rec.arts   More than 200 groups dedicated to certain musicians and bands can be found 
under alt.music . 

b. Grab-bag:  A topic that interests you, one that doesn't interest you, something funny, or 
something serious whatever you like.  Be creative. You will find many groups under the soc 
and talk headings, and you can find alt groups, such as alt.politics, alt.activism, alt.culture, 
alt.current-events, alt.support, and many others (there are already more than 3000 alt 
groups).  Find some of your own. 

2. Try different keywords, as explained above, until you find two newsgroups (one from each 
category listed above) that are of interest.  Read at least three articles (messages) from each 
of the two newsgroups that you selected.  If the articles you read are particularly 
uninteresting, try reading a few more until you find some that are. 

 Send an email message to     (this can come after Part 1 if you'd like, or as a separate message): 
 awilson@cs.unc.edu 
 Subject line: [just leave as you typed it in Part I if you are sending both together; if you're 

sending Part II separately, use this as your subject: 
    Asg-01, COMP 96, PART II 
Include your real name as the first line of your message.   
Your message should include, at minimum: 
 PART II: Usenet 
And, for each newsgroup (please identify newsgroup NAME first), you must include: 

a. About a paragraph that describes something you learned in that newsgroup, and  
b. Your reaction to what you read in each newsgroup.   
c. Why you chose that particular topic (brief; sentence or two). 

Type the word "Pledge" followed by your initials at the bottom of message, if you haven't yet. 

C. QUIT all applications, and LOG Off of Windows NT.   
 

Attached:  Additional URLs to explore; Grading Rubric we'll use 28 June 2001 

mailto:awilson@cs.unc.edu

